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�ً���W:"G"�F* ا*�أ ���؟.... وإدراج ا� %ر و�	Z ا=ر�S�Y�ت *�E ا� ���ت ا�   آ��

دراج* ����? C( ا� :-I"]^	ا� ���. W, ا*�أ *��FL�*�) وHP أوG	�E أو �G�ر( C( أي �G"� "`P وC( أي _
[�O�T' :�M� وأردت a�* b�
آ	�ل ا�e	�� ا���** �D��U�� H�d ا=�DF�ل ا�FL�C �*( ا��"و )��Fا� "`��� Enter  �C��	ن ا�%LFP

) ا��`%ر و�EL اE�* H�Iآ�S"ة Shift+Enter ) . ] 
�� Picture اInsert ,W"FA ا�D�@	� اf:gFC%رة 
دراج*M' "FAا �	@�. gF�FP From File ذ� N اFA" ا� %رة ا��G"� )Fه�*+�

H�IواOK.  
*-I%� ى أو � %رة"Aأ ��� � N�DM� ، ���	�� �' R�� أو NM� ط أو�Sأو ار� ��fأو وH�dا� �M� ��' يV وورد أو �MF�	�
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(1): )Cb	. )Fت ا�����" ا� OFP ����	ا� oه���O��� Z	Z ار�S�ط إ�U ه�o ا� ���ت..*���P وس .. وه�ا�	��أ[" * HDC
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v�TFP��	_ أن"�Mه H�Iا "gSfأ����� أSf�b ار�S�ط � ��� HA أي أF�� ى"Aأ "Aw ��	� أو.
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** v�= ��C RFLG ان ReG ط�Sأن ا=ر� ,P=ا ��	اد ا��F'اد... '- ا�F'�* دة�ن �%L� a'ا"Sا� Tًk	C exe أوzip �ReG ا� N��� 
����e' a'ا"* ���f Z	� bS{اد اذا ر�F'=ه�ا ا �*�Fآ...Z	� اردت %� Tًk	C ط�Sار� ,P�* a'��"* Z�	�F� mIRC %ه oاد�F'وا 

exe  ط�Sن ا=ر�%LG ان ReG)��F��آ:،exe .mIRC��. وه�Lا ���DS ا�	���ت *�TFAف ا'�Fادا�
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1- ,.)Fا� %ر ا� v��* ��'�lF�FP EGاد�F'=ا ��}* N+.%' )C jpeg أوgif.  
��� jpeg ا'�Fاد �lF�FPم ��~*� = UF� ���= �Z��D� ZSD أ�%ا )Fأو ا� %ر ا� ��+�S`ا� "n�M	�� ��F.د .
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�F"ض]G )��Fا� ��e	ا� )C N����f -�	_ v�� a�* b����N��� ReG N أن �_ -d	�C C:/mydocument/myweb ..  -"و
��e' )C ��'�lF�FP )Fا� N����'myweb  ���� '��e دا� ZS. .ZA	Z اي ار�S�ط �� a�* b��F"ض C"و�C ر% �� �S�M��* �'أ ��e' 

myweb %وه images N+.%' ن�اذا آ �f�A ���C N�Cا"eا� %ر وا� -d� أن Zd�G N��� �*��M' "�Sد آ�� ..)C ��O��FP أي 
c:/mydocument/myweb/images ذ� �� ار�S�ط آ	� �+�	C b( ا���*�D� N)C%م *�درا_��و*+�� -M � أو ���.. ا� 

��ا� f��gو*��LG N%ن '��ر ا�lFPا' �r��	* Zآ�ون '��* �LS��� ����Pار �M� "�Oو� ] .
*�DG"Y �+* ز��eا� )C ����v ا� ����	�:
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أن C Save%ق اP, ا� ��� *+� ذ�N اM Change H�I��Cة وذ�* N��U�� H�dا� v�TFP a'��"Sا� ��e' )C ��O�� myweb 

�ً��w ��.آ	� ذآ"
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1- ReG ����@"ا� ����" 'S�["ة ��M آF�Index �* أن LG%ن اP, ا� O� UF� Nان وذ�%M� U_� إ���دون ا� g� F	ا� )C N+.%'

,Pا �*�Fآoه� ���. ا� 
2- ReG ا�"'%ز E' q'أو أي ر ���وا�	%_%دة C( �%�� ا�	����g و= ���lFم ا�	+"و�C أن ���lFم ا��"وف ا�FL� ��M��T�*� اP, ا� 
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؟؟ا	,�T"؟0; �����; آ*( T*8/ن �\�ر#
b���زكC( أ_ ��e' )C N����' v��* b	. myweb ر�ا��ي '�oc:/mydocument/myweb ر��	ل ه�ا ا��SF��P ,P�*

Tk' gS �P أي N+.%'www.des4arab.com ،�LSا�� Uإ� N����' ZDMFPو #�M* زك��_ )C ��S��"� .. ��e' NG�� b�C	Tًk أ
,P�* %وه N+.%' ر%f -�	_ ��C v���images .. -dو� �LSا�� )C N+.%' )C ,P=ا #�M* ��e' ء��� _ ��C	�DFP N���-%م *�

��. ا�	��lF'� ا� %ر�	+* b	. )Fا� RG%ت ا����f Zk' ى"AVت ا���	�� �S�M��* �'أ )Fاد وا��F'�* q�	F� (htm.) ،�MF�' أو
)C زك��_ )C ��F+Iو b�}C �أو }�"ه ، �� إ�U ا��SM_ images..  �LSً� إ���e' myweb ��e' -' RM_ Uوورد�P"FP N���

��e' R��e*images .. ��*ا� و �r��	* �LSا�� U�� ت�Y�Sا=ر� gFC )C Zآ�ث '���� E� N.
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��NF ا�lFPامf )C اول�eا� Z+eG �ًCا"Fوا� �ً	�OM� "kاآ ��M' ...R��e* ?� H�P%� -�`F�� E� اول�eا� "�{ E	C رة%f -d� أو

ر HA -d� ورة أو�eF' ة�	أ� ZL] U�� ص% ���E. إ�� ... أP( أو أو N��� N� � ����Dوا� NF��f )C اول�eام ا��lFP�*!!

: ا	45اولا�4أ ��8-47ام واaن#

H�Iدوات ا�+�%ي اVا HG"] )C ادراج _�ول q'ر U�� ))C واFA" ��د ا�V	�ة وا� �%ف) اVو�U ا�l`%ة را_- ["ح ا�"'%ز
.د ��د ا�GTl� و�� insert>table أو ا�lFPم. ا��G"� )Fه� 

*v�TFP ول�eأن ��ود ا� ���Aرزة ا��ا�ر_�� *�lوا� ..)C ���l' ول�eود ا��� �G"� bMذا �% آ�	C (Preview) ه"ة�nو )C
,�.(Normal)  ؟؟ �G"� �' و��رج ��+' Z'�+F�� ... �`��*!!
-I"]^	ا� )C��M' "FAا �	@�. gF�FP رة���Table Properties gF أي ���A داZA ا��eول وا�G "D	�E ا�FP gI%� ة�C�� N�

)��F��ول وه( آ�eا� ?@� A:

(1): �G��F� )C . ا� ���'%I- ا��eول
(2): ��F��GE�* �C��	ا��GTlا� .
(3): E'NML	G ر��lء ه�ا ا���Aر ا�Y
�g وذ��. -I%* N	� P	N ا F	ا� )C ول�eود ا��� Border=0 ،�Mه E' NML	Gو �ًdGأ 

N	P دة�Gرز�Y
. ا
.ا�GTl� �%ن ا
Y�ر �%ل =�FA�ر :(4)
��� =�FA�ر :(5)�A ول�%ن�e�� .
��� =�FA�ر :(6)�lرة آ%fول�e�� .
. ا��eول GTA� �"ض وار���ع =�FA�ر :(7)
�* E�F��FA�ر :(8)�lا� E' E�SP�M' E��%� Light border وDark border  ��� وه�ا..*�رزةG	GTA Z+_ NMLM� ا��eول وآ{

Z�	_ "�O' ��`+�P.



��

,.H�Iوا ?@� A E' br] �' ر��FA�* OK . 

** �O�T' ** 
ا�أي( ?@� A E' oر�FlFP ر��FAاU�� �S`M�P ول�e -�	_ �GTAول�eا� (

ELو�U�� �M�+' ?@� A ��S`� ذا �% أردت�' ���A H��* "'V؟؟ ا ��DSدون ا� �GTlا� E' ��%	e' وا��ة أو ..!! 

1- ���l� "]^	ا� -I وا��ة���Aا�* ..�GTA و�+�ة ,.�GTlا� oه� �G��F*.
2- H�Iا "FAرة وا���" �N ا�M��Cة ا�F���� ا� A gI%� )F�G Cell Properties FP?@	�E ا�O���lا�:

�� *l �@? آ	� -3�S] ����� اFA".. ا��eول�v�T أM' E' �G"� �'H�Iا ,W دة��' �GTA وا��ة أو ���A U�� ��D�S`F� ?@� A 
OK . 
** �O�T' ** 

),��� ZdCأ ZL�* ���� C( ا��"و�a�* b ا��v ا��eاول وا�F+"ف إ���D+� Uا��FCوا ��	�	 � )C ًا��D+� ى"� UFت ا���� ٢٠٠٠ا� 
(.

����� �
���� )�	
 ��
�9��
 "�	��v(:

#hًأو :di Xj� )*آ ;A0؟0; أ=-'�. 
-I%�HA )DCأ Uإ� Rاذه ����" �N ا�Hl *���ادا�� C Insert>Horizontal Line( ا� O�P ��Iا"FC=ا ...  NML	G EL�

�G"� �' R�� �؟..����"ه  آ��
"D��D"ة 'qدو_� ��U ا Hlا� ����Fة ا��C�Mا� N� "�OFP �ه�M� )DCVا:



��

 ا�Hl �%ن : (3) ا�P Hl	N : (2) ا�Y Hl%ل : (1)

#�ً*��c :آ*( �4رج k0; ر�  .�'-=؟ ��

دراج q'ر Uإ� Rاذه Insert>Symbol �Sد آ�� �����Cة * gF�FP ا�"'%ز E' "..��M' "FAا H�Iوا Insert H�Iا ,W 

Close . 

#�ً<	�c :Xj� )*0; ��4اد آ ;BA� ؟ ر<:; أو=-'�. 
�� *{ي [ZL أيS��e* ط�D� -Iأو و ��	�."� �G"و� "`PVا E' د�� NG�� ن�آ %� b�؟ .. آ� Z+� C	�ذا �

1- RFاآ �G"� )Fا��`%ر ا� ���� *%ا �".�	M�* ل�DF� . HDC Enter+Shift و��# �F`P Enterوا_+Z ا=
2- Z�n Uإ� Rواذه ��	�."� �G"� )Fا��`%ر ا� Format>Bullest and Numbering H�Iا ,W �G"� �' ��M' "FAوا OK. 

b�Sfأ "`PVا E�* �C��	أن ا� �eFPة"��f .

ة C	���K ا K �

l�;0 آ*( �4رج: را��ً�#  '-=؟.��-'�ك
Rاذه Uإ� Insert>Component>Marquee ����Fة ا��C�Mا� N� gF�FP :
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(1): RFاآ ?Mا� �Mكه"�F	ا� .
(2): ��"P NG"��?Mا� .
.ا��"آ� �%ع :(3)
(4): -I%� ?Mا� ����l� ك�%ن"�F	ا� .
"FAا H�Iا ,W �G"� �' OK ... ,�. )C �FMG�+	* ,. Preview . 
�D"اً 'qدو_ً��% "D��" ا�M��Cة ا���*U�� �D اردت ����" ا=��ادات اOFP ك"�F	ا� ?Mا� ..H�Iا ,W N�TG�+� "_أ OK . 

#�ً\��i :;ه �� "*.�i /ك�	رك؟ ا�� 
Zه �SP N؟� ����# ا� � )C ELو� "Aw ن�L' Uإ� N�DMG ط�Sار� U�� H�d� �'�M� -.%' أن زرت ���!! A���f ا�S%ك '�رك ا

���P ���	+��C ����Fات ا�%`l*- ا��؟ � ���	� ,FG ��LC:
.'+�E ار�S�ط ا�M? أو ا� %رة ا��G"� )F ا�qا@" أن ZDFMG إ���� �H�I �M ��د -1
2- Rاذه Uإ� Insert>Bookmark ة�C�Mا� gF�FP ����Fا�:



�	

3- RFاآ ���A )C أو ا� %رة ?Mا ا���� ,Pا Bookmark name H�Iا ,W OK.  
�� ��ZDFM إ��G"� U ا�M? أو ا� %رة ا�F( ��د -4`�dG ا@" أنqكا��Mه .
5- Rاذه Uإ� Insert>Hyperlink  ة�C�Mا� gF�FP����Fا� :

�	M� C( ه�o ا�q_ HDC �`DMء 'E ا�M��Cة ه�اG �' %وه 

6- gFCا �	ار آ�%e* ����M	ا� �	@�Dا� Bookmark �eFP ةأن%`lا� )C �FSFا��ي آ ,P=٣(ا(H�Iا ,W oر��FA�* ,. �Mد ه%_%' 
OK.  
,.�F*"eF* �MG�+	ا� )C ...�آ �b ا�	��E�* �C ا=ر�S�ط وا���فو�N� gdFG E� EL إ= إذا "S[� أآ�ع ا����٠'E ار�

؟ �٢٠٠٠-e*�ة �/اB8" �0و�[ �*� أزرار آ*( �4رج: �8د#�ً8
Zأو ه ��%� "��FG زر U�� رة��؟ FG�"ك N� �SP أن زرت '%.- ��M '"ور ا� "�W}� ث �� أي��G أو ... oه� �+* Z	� NML	G

a�* b�:آ��F��(  2000 ا��W}F"ات *%اC �`P"و
1- -I��C رqر ا�%�n �G"� ن ا��ي�L	ا� )C "]^	ا� .
2- Rاذه Uإ� Insert>component>Hover Button ة�C�Mا� gF�FP ����Fا�:

: ا�F����ا��l�رات ��د -3
(1): )Cرqا� )C oر%�n �G"� ا��ي ?Mا� RFاآ ���lا� oه�.
(2): ���. ا�qرا��G"� )F ا�qا@" ZDFMG إ���� �H�I �M ا� 
. ا�qر �%ن :(3)
�%ع :(4) "�W}Fا�.
. ا�qر �"ض :(5)
.ا�qر ار���ع :(6)



�


 . eF* ,. ,W Preview"*� ا�C "�W}F( .�, ا�	+�HSI OK ،�MG ا
��ادات اH�Iو*+�
** �O�T' ** 

�gF ا�M��Cة ا���** ,. ,W �D��TG�+Fت ا�Tز'� واU�� H�I اردت ����" ا=��ادات ا�D" ا�qر �D"اً 'qدو_ً��%[FP رqا� OK [

����� ����� )"��'U�: (
[ '	E آbM إذا ** U�� �ً�S��، *� ا�+�E' �G ا�	���تG	�L%ن '%.+ً� آ�S"اً  b�"F�
N'q��C أن �L%ن ه�o ا�	���ت، ا�	�LS ��%MF ا

 �	�C N+.%' إدارة Z���� �ً	�OM� "kأآ�+*.N+.%' )C ات��e' Z	+* Nوذ�.

؟�/<�=و	�T آ*( �-� �pZ*� ه`o ا	:���ت دا�i �5�4ات 0;  ##
1- N��� �ً	@T' �ً��M � N+.%' م�أ.� ��M F* =ًأو �G%F�	���.
2- �+* U�� ل�G �	* �	Pو ,�. ZL� ��e' Z	+* ,. Nت ذ��G%F�' ه�ا,�Dا� .

�F"ض أن ��MG� ً+.%'� dG, اV.��م ا�F����k' :�ل  **M� :
-,�. a'ا"* ����e' .
-�SFL' ر%f .
-�SFL' ��+	P .
-,�. )	��+� .

��ز ��e' )C أر*+� *����ءDMP%مeا� )C ات��e' myweb )Iا"FC=ا�	* ��e' Zآ )	��، و N+.%' ت��... ��' U�F%ا�G oل �	�
:C	L� Tًk%ن أP	�ء اV.��م ا���*U�� �D ا�F%ا�(

- software . 
- Pictures 

- songs 
- edu 
�Mو���� RP�M	ا� ��e	ا� )C ���f Zآ v�" 'f ��e%ر *�P, إ���ء وG	NML. إ���ء ا� ���ت DMP%م *� img "  Zآ ZAدا ، Tًk'
E'�f�lا� %ر ا� v�..�, *ZL ه�o ا�	��eات ��

: اq<\�م
:� اhر���@�ت �*� .�'�ت و����ت#

��� ر@���� ��	%.- A�رج-f ك�Mن ه%LFP �Gا�Sا� )C oه� ,P�*ات و��e	ا� index ،����@ر ���fو index  ��e' Zآ ZAدا
),�.(.

��� ا�	%.- ا�"و*��F{آ��f )C N+.%' م�أ.� Uإ� "��FPت�Y�Sار� -I%* ����@ ��؟ .... �  T-8 )*T0/ن ه`o اhر���@�ت
:G	� NML	Z ذ�N *���ى edu  E�FDG"Y ا� ��� ا�"@���� ��D, إ�I%� U- ار�S�ط، 'Tًk: أوً=
�� ��`�"(أ�A )C �ًGو�G ان%M+ا� URL ،)��F��ن آ%LG ~��*:

,WH�I OK . م%DG �'�Mا@" و�qا�"@���� ا� ����D�� g�ً�@� D*"اءة ا�  F	م ا�%D�P ط�Sه�ا ا=ر� H�d* index ا��� ,�Dا� " edu 
" .
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�� ا�	���ت اFP+"اض(ب�A E' ����D%م *�CCreate Hyperlink ��e' gF( ه�o ا�  ~��* edu ���f U�� "�]}Fوا� 
index ,W ��Aا�* H�d� OK .  )��Fا� ZLا�� )C �	آ:

�ً���W:�:
 �ir �\> ;0 "'�. �� �� �\> ;0 "'��	 ار���ط :
��� MG�� ,�. )C�k':�ل  **f software ,P�* internet.htm ،ط�Sار� ���C -d��"�G أن  ��� � wall.htm ,�. )C 

pictures . E�FDG"Y ى���* Nذ� Z	� NML	G :
:ا�+M%ان �GوGً� ��`�"(أ

1- gFCا ���f internet.htm Ca�* b�.( ا��"و
. ار�S�طأو ا� %رة ا��G"� )Fه� أن �L%ن ا�+S�رة ��U ا[" -2
3- gFCة ا�C�� Create Hyperlink . 
4- )C���A URL  �' RFاآ)�G:

'E/..أن ��~ **  . wall.htm وا���DS وf%ل � ���، A )M+� ��e' software"وج
  .OK اH�I وأ�A"اً -5
:ا�+M%ان أ�%'����Lً� ادA�ل(ب

1- gFCا ���f internet.htm  a�* b�.C( ا��"و
. ار�S�طأو ا� %رة ا��G"� )Fه� أن �L%ن ا�+S�رة ��U ا[" -2
3- CاgFة�C�� Create Hyperlink.  
4- E'��e' gFCا U��Vا pictures اض"+FP= -�	_���G%F�' .
��� أ[" -5f U�� wall ,WH�Iا OK.  
** o�����ت ا�`"G �DG	� NML	Z ار�S�Y�ت *�E _	�- و*f م�ت أ.���. '%.+Nو'�

���ء '��eات وأ�A"اً[�* ,. )C�	Pوأ ��S��"� #�M* �LSا�� )C N+.%'�' Uإ� ,�. Zت آ���f ZD�، وا ��زك_ )C �ءه ��W�	G )C
NSا�� [.
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����� ������ )"���9�� 
q "���g��: (
#;Z�� رات؟ ��ذا�@uا 
)M+�"�{ ZL�* ELو� ، ��DF�' ���f Zk	G ��M' Zم آ�ة أ.��� Uإ� ������D� v�T' g, ا�  F	ا� ?l���.
*Zk':-Iو �	@�. �W E�	ا�� )C )C ت���= �F* "��F��" ا�  �F*ر�ا��� .
*�O�T':�	آ ���� ��M ا�lFPا'N '��ويء أن ��Y�رات '�qات �Cن �C"+FP���.

:�#� �/اB8" ا	��و�[# �T:� ;-	رات ا�@u؟ ٢٠٠٠ �*� �� ه; أ�/اع ا
"C%Gb��� ٢٠٠٠ *�C N� a"وM' �G"� �' ام�lFPا NML	G ، .��ة أ[L�ل _�هqة ���"G	�ت

NML	Gه�ةو��' )��F��ل آ�L]Vا oه�:
1- E'�	@�. File "FAا New ,WPage . 
2- gF��P U��Vا E' "FAا ،   .Frames '"*- �%ار

3- "�OFP ل�L]ة أ�� N� ت�	G"��� ،�' U�� "�]}F��* %ار�ا� -*"' E' )���� C( ا��D, اGV	E ا��FMG�+' NML	G �G"� ،�+*و
H�Iر ا��FA=ا OK.  

Nوإ��)��Fل ا��k	ا�:
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��� إذا-f ء)�M� ة أردت أن�G�_ H�Iر ا�Yأي إ )C NewPage . 
��� أ'�-f NG�� b��%ره� C( أ�� ه�o ا
Y�رات C�H�I _�هqة إذا آ�n �G"و� Set initial Page.  

** �+* o�� U�� ر�Yإ Zآ ?@� A �G��F* ,. Nذ� )��F��آ:
. A��* � @	�E ا��{رة ��U ا
Y�ر ا��ي �"� �G���G اH�I-أ
 . Frame Properties ا�D�@	� اE'"FA-ب
�"-جO�P )��F��آ ,G"�:�A -*"' N �@? ه�ا ا�

1- ,Pه�ا ا ,G"�.ا�
.ا��"G,ا� ��� ا��FP )Fر_�� C( ه�ا �M%ان -2
. ا��"G,ه�ا �"ض -3

** �O�T':)L� -Sف د.� ا�+"ض ا�TFA�* رات�Y
: ا�F��ZL] o%�FG =) ا
، أG	E هM�ك C( ا��ZL ا���*�آ	� HDC ران�Yا"�Gوأ .�C(إذا آ��b ا�D�@	� C( ا����ر وا�  DM�C%م *F���G ا��	�E �� ا�"@����

R�� �ً�@�D�� "��FG "Aك ا�"F�، و Z�LS��* �	@�Dر ا��Yد.� �"ض إ g� F	�� ا�+"ض.

-Tًk':Z+e� �	@�Dو�"ض�١٥٠"ض ا� ، Z�L* ر�Yآ� إ"F�  .١Relativeا� ��� ا�"@���� 
C(، ا
Y�ر ار���ع -4 �Z اU��V أو C( وه�ا �� E�F�_� إ= إذا اb'�lFP إY�راتPVا.
5- ,.E	� �G"� = bMإذا آ ��.�Fا� -*"' E' رة�]
�g *�زا�� ا FG ت�P�D' "��G أن N+.%'رات�Y
. ا
6- H�Iا �	�. Z+_ر واqه�ا ا� Frame Spacing  Zء ��ود آ��A
 ، �"اًfرات�Y
. ا
:أن*{["�Y ا�F	G"" ا�"أ��P واA ~�� ��DCV�ص ا��l�ر ه�ا -7

- If Needed: ر%�n �� .ا��"�M� HG ا���_�
- Always:oر%�n ار"	FP�*.
- Never:م�� oر%�n�ً�@���.

[#�M*و "Aا� ,G"�[ ا�`"G �DG	� NML��A �G �@? ا� .
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:ا	���:�ت( ا	��'�ت ا	-; �\-47م اu@�رات0; آ*�*" وX1 اhر���@�ت ## (
�M� ReG رات�Y
�gF) ا��"� N��� ),G���G ا
Y�ر ا�lFPا'�DG"`� N اFP ا��ي ��C )��F��آ Nوذ� ، :ا� ��� �H�I �M ار�S�ط '�
.أو ا� %رة ا��G"� )Fه� أن �L%ن ار�S�ط ا�+S�رة ��� أ[" -1
2- gFCة ا�C�� Create Hyperlink.  
3- RFاآ o�G"� ط ا��ي�Sا=ر� )C���A URL.  

4- H�Iزر ا U�� U�� Target Frame ،ZLا�� N� "�O�P )��Fا�:

** NML	G gFC ن�L' ر��FAا ����� ا� �lا� E' (1) "�]}F��* رة}��� ا�	M��SP أو 'E ا�FA�ر ا�+S�رة. *���lا� E' (2) ،~��:

Page Default [main : gF�� U	�	ا� )Iا"FC=ر ا�Y
 . main ا� ��� C( ا
Same Frame:gFC C#��. ا
Y�ر( 

Whole Page, Parent Frame:gFC Z'�ر آ�Yإ )C)���f ��'�آ . (
New Window: gFC Uو�Vا ���، *��~ �UDS ا�  ���Cة _��Gة )C��%F�'.

  .OK اH�I وأ�A"اً -5

X
�� ... �+3�� "���g� �89z �+;z �-� 



��

����� �
���� )¢R�/;��(:
hً؟: أو ؟ و�� ه; �4y�0#���ه; ا	Z:�ذج

�� H�dG ,W زر ارP�ل وا=�FA�رات ه( �S�رة �e' E	E' ��% ا��D%ل ا�M	�ذجM' �G"G �' ر��FAوا �rS+F* "@اqم ا�%DG ( Submit 
)"�OF� ة"]�S' ك�G"S� ZP"� أو N+.%' )C ���f )C �e�FMا�.

�ً*��c:ذج/:Z	ت �/ل ا��/���:

�(وFORM> MG> ا�M	%ذج *%�SG ,Pأ-F ,P%* </FORM> . 
�Zk' b ا�M	%ذج *�دارة DG%م-"F�
��'FL' a%ب *���ى ���ت ا"* NM� �*��� perl ، php ، asp.  
-)L� H*"� ا��ي a'��"Sا� Z	+G أن ReG N+.%' )C ذج%	Mا� Z	+G �*ZL�* ذج%	Mه�ا ا�,��P ."C"ا��� ,��G أن R�`FG وه�ا

��'a ا�	�� ��dF	Z���� N+.% ه�ا"Sا� .
-ZS. ن%LG أن ReG N+.%' )C ذج%	�، وا��MP )Fآ" C( ه�ا ��NG ا��Sء C( إ���ء  a'ا"Sا� oه� Rآ�"� �DG"`* �`��* %و� �C"+'

wي ��U ا��رس 'k�ل )_ )P a'��" �"آ�R أ��ه� وه% *" Cgi “.  

�ً<	�c:ذج�:Z	:\-�47" 0; ا	رات ا�*-ihل وا/A'	�� )���-	ا :

دراج )C �	%ذجNF��f �	* �	@�. Uإ� Rاذه ، ��ت�A E' �G%F�G Insert U�� "]أ ,W Form ،��* �	@�. N� gF�FP �')�G:

 ا	,ــــــ�ح ا�qـــ�

Form 
¢��� �-c;� ¢R�£ @�Z�%� ���$q `  ��y G'H �-� }��x �890�� =( Submit )  �Fp�

��/'�)Reset ) . 

On-Line Text Box ¢��� �
�� d��$�
 �c�
.
Scrolling Text Box ¢��� �
�� d����� ���� B
 ` �cZf� ��+��.

Check Box ¢��� �
�� ~	��: �K;� �$�
  � �6�q ��	�F� �3�V'�  ��.
Radio Button ¢��� �y��	�F� ،�-� �$�
 s� �K;� ���¤ _q �3�V�� �	c��� s n	¥.

Drop-Down Menu ¢���� �/3�� � 7!
 ` S9Z[� ����;� M56��� "���	�F%� ��Z�;.
Push Button ¢���� ���yf� ... ¦��9�� N��9�� �� T�	3�-': ¢���Z ���yf�� BL��x s.

Picture ¢��� M��z *;�� �V�� @�
 �K���{�Z�.

: �>�ل �u,�ء 0/رم ���4ي 0; �/<�=:را��ً�
؟ '�ذا ** �%رم ا��G"Sي��* )M+� 
%�'S�["ة 'N+.%' E دون ا���_� =�lFPام *"�G"S� o�Gك ا��G"Sي ه% �	%ذج F�G`�- ا�qا@" '��TA E أن N� ZP"G رP���رما�

�T�...ZرP�ل�G v�T� �	وه% آ U�� ����� �+e�Gل و�Pا=ر ���	ا@" �qا�.

: A`%ة A`%ة ��SMأ '+ً� إ���ء ه�ا ا��%رم وا�ن ##



��

E'رم%�أن TA -�`F�Gل ه�ا ا� :ا�qا@"
-ZP"G أو )D�D�ا� �	Pا N� ر�+F�	ا� .
.����*"o�G ا
�FL"و�( ��F	E' EL ا�"د �Gرج-
. �"P��M��F%ان G��د-
-RFLG ���Pر N��	آ�G"G .

:ا	B7ـــــــــــ/ات*
1- gFCا �	@�. Insert U�� "]وأ Form ، �	@�. gF�FP "FAا ��M' Form.  
، أ��ه	��v�T �, إدراج '�آ	� ه�ا.��	�g وا�FL�T� Reset  �G�_ E' �*رP�ل وا�Z�`F Submit "A *�� أP%د 'DF`- *� زران

= qGال �MLرم و�%�. C�رغ ه% ا�
*"���F� Submit وReset U�� g�'ل و�Pار Uا�( إ�%Fزر، ا� U�� �_دوq' ة"D� "D�وا�SFPل ه�o ا��L	� *ـ  Submit ا

#�M*و ، . '�gإ�Reset  U }�" ا�`"�DG ارP�ل
�%ف وادرج ا�	^[" داZA ا��%رم ا�"ك -2f �+*ول *{ر�_EG%د	و� .

3- RFاآ E	GV%د ا	ا�+ )C R��"F��* Uأ�� E'Z�PV :
:ا=Pــــ,-
: ا
�FL"و�(*"�Gك �M%ان-
:رP��M� NF%ان-
-RFاآ NF��Pر :

4- )C���lا� Uو�Vو�� ا ?�: آ��F��(� ا��`" 'E ا�+	%د ا�GV" أدرج '"*- 
Insert>Form>On-Line Text Box  

,W، �D"ة 'qدو_� ���� "D��� وC( ا�A Name RFاآ name ,WH�Iا OK.  
5- )C-' Uو�Vا ���lا� )C �	آ ����kا� ���lا� "���� ���A )C ,P=ا Name Uإ� email.  
6- )Cان%M+� رات��A ة�� ��* ����M' �	@�. �Iأ �k��kا� ���lا�Nوذ� ���P"ا� )��F��آ:

Insert>Form>Drop-Down Menu  
,W���A )Cدو_� وq' ة"D� ���� "D�: آ��F��(��د �A�رات ا�+M%ان  OK و.ZS أن �subject ،H�d اآName RF ا
زر اH�I-أ U�� Add ���A )Cو Choice  RFاآ "NF��P"� ان%M� "FAا "H�Iا ,W OK.  
Add )C أA"ى اH�I '"ة-ب RFواآ���A Choice H�Iا ,W �rM� . L] OK" و�
�#-جM*و H�Iا ,W ،  Drop-Down Menu '"*- �%ار 
}Tق OK ا�`"�DG أ�I _	�- ا�+M�وEG ا��G"� )Fه�

Properties . 
7- )C���lا�"ا*+� ا� "`PVد ا�+F� ?� -*"' �Iأ)��F��آ :

Insert>Form>Scrolling Text Box  
,W�_دوq' ة"D� ���� "D���ا�A )Cو Name RFاآ massage ,WH�Iا Ok.  

�ً\��i:ذج/:Z	أداء ه`ا ا ��/B� )4ي���	/رم ا�	ا(:
��ت �MP"ح **�A ك"FG E	� }`A ���f و �G"* ZP"G E	� "L] ���f ? l�:وذ�N آ��F��( '`�%*� هM� آ�� 
�� f	,-أ	Pا ELو�� "L] ���f thanks.htm }`A ى"Aوأ ELو�� ��	Pا error.htm  �' ���C RFواآ a�* b�*%اP`� ا��"و

���Pرات وار�S� E' �G"�N+.%	� �LSا�� )C.
'IE--ب ZL* ص�lد ا�%Lا� ���f �`Pا%* Nوذ� �LSا�� )C N+.%' )C E�F�� ا��L" وا�l`{ وا��ي �FPرج M� ��C%ان ا� 

b�:*�a آ��F��( ا��"و

http://www.des4arab.com/home/modules.php?name=Sections&sop=viewarticle&artid=23
http://www.des4arab.com/home/modules.php?name=Sections&sop=viewarticle&artid=3
http://www.des4arab.com/home/modules.php?name=Downloads&d_op=getit&lid=5


��

1- �C�Iإ "Lا�� ���f thanks.htm : 
--IA^[" دا	ا�"FAرة وا}� . ZForm Properties ا��%رم وا�* H�I	�E ا�
-H�Iزر ا U�� Advanced -*"' N� gF��P Z�PVا )C �G�_.
-H�Iزر ا U�� Add RFواآ redirect )C���A Name ،���A )C RFاآ ,W Value Zk' N+.%' )C "Lا�� ���f ان%M� 

http://www.des4arab.com/thanks.htm H�Iوا OK.  
2- �C�Iإ ���f }`lا� error.htm:  
#�M*H�Iا �D*�ا�� �DG"`ا� Add RFواآ missing_fields_redirect )C���A Name ،)C }`lا� ���f ان%M� RFاآ ,W
N+.%'�*����آ.

*}`lا� ���Pر "�O� )Lو� �M� ,. �Gور"dت ا����lك ا�"�)���* :
--IAرة وا}�  .FForm Properties"ا�	^[" داZA ا��%رم وا�* H�I	�E ا�
-H�Iزر ا U�� Advanced Z�PVا )C gF��P -*"' N��G�_ .
-H�Iزر ا U�� Add RFواآ required )C���A Name ،���A )C RFاآ ,W Value ت���lء ا��	Pأ )Fورة ا�"I ى"�

Zk' ��f��* ��% �.TWث '"ات  OK اname,email ,WH�I'�ه� '


�� ���4ك ا	�7ص ور�d ا	�/رم ا	���4ي�'/�� ا	��8:8د8ً� �y� ������	��:
:�"�G أن ��ZSDF ���� ا�"P�Z@ وذ�* N��S�ع ا�F��( ا��ي آF�M� �*%ان ا�ReG �G"S-أ

 . Form Properties واI "FA- ا�	^[" داZA ا��%رم وا�* H�I	�E ا��{رة-
-H�Iزر ا U�� Advanced )CZ�PVا -*"' N� gF��P�G�_ .
زر H�Iا- U�� Add RFواآ recipient ���A )C Name ،���A )C RFاآ ,W Value Zk' )� �M%ان ا��G"S ا
�FL"و

webmaster@des4arab.com H�Iا ,W OK  ثTWات"' .

H*"� )Cأن ReG-ب ����'a آ	� ذآ""S* رم%���ً�" ه�ا ا��W "�	Pا �Mه �'�lF�MP ا��ي a'��"Sوا� FormMail.cgi �+dMPو 
، وDMP%م *+	��� ا�"*H آ��F��( ا�	%.-��e' ZA cgi-bin )Cدا �LSا�� )C:
--I"]^	ا� ZAدا "FAرة وا}� . Form Properties ا��%رم وا�* H�I	�E ا�
��S ا�	����M و�{آ� 'E ا�FA�ر ا��l�ر اVول C( ا�D�@	� U�� Send to other '"*- ا=�FA�ر أ["-�e* .
-H�Iزر ا U�� Options  )C -*"' gF��P Z�PVا�G�_.
-RFاآ ���A )C Action Zk' N+.%' )C a'��"Sان ا�%M� http://www.des4arab.com/cgi-bin/FormMail.cgi  ,W

H�Iا OK E��"' .

�ً���8:"T�,	0; �/<�= 0; ا ������	آ*� ا�� :
-1Z ا� a'��"Sا� U�� H�d��* �Mه

2- NC�C"	ا� "FCا�� )C ��FCوا a'��"Sا� H�I وز�MG%* "WordPad" . 
3- "�{ des4arab.com  N+.%' ان%M� Uإ�)v�= رة"L' ���.)'"��E أ
4- v����r ا�* "���Fا� Text Document.  
-5ZPأر ��e' Uإ� a'��"Sا�bin -cgi)C%'N+. a'��"* �`Pا%* FTP �r��* ASCII..  �G��� NML	G a'��"Sا� Z�Pأ E' oه�

�r��. ا�

�� ا��%رم ا��G"Sي �	%.+N و., وأ�A"اً* )Fا� ����� أرZP ا� F*"eF* ....  E'و N+.%	* ص�A ي�G"* رم%C NG�� gSfا �D� وك"S'
 N+Mf.



��

�����  ��6�� )�	
 ��
�9��  H �/K� "���'+� (:
## �**e� k*��� �	'" إ��	*"ا���	ا:
ReG"���� q�'"� RG%ا� ���fت�آ"�' Z��� )Lو� ��= �%ا_� '��آZ أMW�ء � 	�	 UF� ��*"+ا� Uإ� ~�Sا� �M� ��C( ا�+k%ر ���

: وذ�N آ��F��(.... ا�S�E� ~ ا�	%ا.- ا�+"*��
1- gFCة ا�G�_ ���f.
2- H�Iا E�	�* رة}�. ا�D�@	�C Page Properties  E'( أي 'L�ن C( ا� ��� واFA" ا�
3- E'T� U�� H�Iا U��VاRG%SFا� �' Language.  
4- Z+_ر ا��lا�+"*�� ا� U�� ولVا +,PاNFدو� .
5- Z+_ا )��kر ا���lا� ~��kوا� Arabic.  
6- H�Iا OK  )C Z	+ا*�أ ا� ,W���.ا� 


��; أو �d�-7� l $�� آ*�*" ## l� "��-4 آZ
 "A\Z� "'��	ا);��
:)ا�k*�5ي- 
�F"ضGb���٢٠٠٠*�a ا��"وf ر أي�ا��� E' ب%FL	ا� ?M�� �SP�M' ����� أ�F� "��� "Lift To Right	��G�_ �Eة �D%م *

 وذ�N *{�� ا��l�رات ا�F���� Right To Lift"" ا�e�o ا�M? إ�� U�ZG% ��ا M��� ReG�..وا�M? ا�+"*( آ	� �+�, 'E ا��	�E �����ر
:

1- "���� E' ����Z ا��"و�HTML  a�* b وذ�html dir=rtl> . ,�. E' N> إ�html> U> وP, *�ا�G ا� Pأ )C٢٠٠٠ �	آ 
)C ��.اVول ا��رسذآ"

2- E' ,�eا� �D`M' �Gا�* ,Pأو ����" و <body> Uإ� <body dir=rtl>.  
*�O�T':])Cل�DF�ا�F	G"" ا�"أE' )P ا��	�E إ�U ا����ر �+' �M��MG ا� ��� C( ا��"و�HG"] a�* b ا��l�رEG ا���*v�TFP E�D ا

)C أو g� F	ا� [
، ��~ G	NML ����" ا�e�o ا�M? إ�U ا�+"*�� C( ا�M? ا�	FL%ب دا* ,�OMF� ZA��lFPام ا��eاولأو -3 ���، وذ�N ا��eول ا�  HDC

E' ول�eا� �Gا�* ,Pو "���F*<table> Uإ� <table dir=rtl> . 
*�'���A "���� E وا��ة HDCأو -4 ,Pو "���F* Nوذ� ، 'GTAE� ا��eول ���lا� �Gا <td> Uإ� <td dir=rtl>.  ك إذا����P وه�ا

�G"ر و������ E�	ا�� E' ���أن أنآ�ن ا�e�o ا�L� ?M�Z' ا�  ~�� ، �ً	�OM� "kول و_+�� أآ�eا� �GTA أ�� )C يq��e��? ا -d�
 . <td dir=ltr> وP, *�ا�G ا�Z+_ ���lآ' Z� ���N ه%

'Eا�� ?M	D`- أو DC" ا�e�o ����"أو -5 p dir=rtl> ،)C> إ�p> U>ة '��دة وذ�F* N���" وP, *�ا�G ا��D"ة ���ك�P %وه
?Mا� Zk' o"*� ذآ�ا�� E�	��� ر�ا��� E' ?� ���Mي�q��e�ه% ا= ��*"� ���f )C يq��e� * <p��gS G ~ وP, *�ا�G ا�M? ا=

dir=ltr> #و�� <p dir=rtl>.  
['O�Tـــــ�  ***  . [ ZS. dir آF�*�ا�	���C دا@	ً� ��آ":

## l� d�1 �:و0/8[ آ�T*� ;0وورد:
HSd��G��� -�	_ E' ، }ّ�" وP, *�ا�G ا��D"ة �? '+�FL' E%ب DC )C"ة وا��ة "`Pأ <p> Uأ�� إ� ����Fوا'" ا�Vا:

http:///


�	

1- <P dir="rtl" style="TEXT-ALIGN: justify"> . 
 2- <P dir="rtl" style=" TEXT-ALIGN: justify; TEXT-JUSTIFY: inter-word">.  
 3- <P dir="rtl" style=" TEXT-ALIGN: justify; TEXT-JUSTIFY: newspaper">.  
4- <P dir="rtl" style=" TEXT-ALIGN: justify; TEXT-JUSTIFY: kashida">.  
 

## "A��@ X1و�[ �*� و��	ا "B84ة ار���@�ت 0; ./رة وا�4ة �/ا
٢٠٠٠:
. ا� ���C(ج ا� %رةأدر -1
�HG"] Z أدوات ... أ[" ��U ا� %رة *���{رة  -2PVا )C "�O�Pا� %رة.
ه( -3 �� واZL] -Mf �%ل أي _qء 'E ا� %رة �"o�G أن gS G اC �eFP H�I( ا��"�WTW HG أ[L�لM' �G"� �'
.ار�S�ط

�gF '"*- �%ار وI- ا=ر�S�ط -4�P ا� %رة )C ZLا�� -Iو Z	L� أن �+* Create Hyperlink ،�G"� ط ا��ي�Sا=ر� -I
H�IواOK . 

## l� X1/	 �#p� ار���ط ��
:��; ار���ط، ��; �>�
4Z ��ور ا	�Vرة 
�� ./رة أو 
�?(أ"�OG U�� "ور	ا� �M��M� ZG�* ?Mم آ�lF�G %وه ، �%ر ا� %رة أو ���"ح �%ل '� ���ف إ��� ا� %رة ��م ا� %رةn

 )��F��آ ��	� ,FGو ،:
.C( ا� ��� ا� %رة أدرج -1
2- H�Iا E' "FAرة وا}�  .Picture Properties ا�D�@	� ��U ا� %رة *�	�E ا�
3- RFاآ ���A )C Text ?Mا��ي ا� H�Iا ,W �G"� OK.  
�-ب?U�� رة}�� ( ار�S�ط ��M '"ور ا�:

1- Z�n `�%ب	ا� ?Mا� U��.
2- gFCا ,�. HTML Z�Pأ )C b�. ٢٠٠٠*�a ا��"و
3- �eFP �Iأ ، ���O' ?Mا ا���* �f�lة ا�"�:ا�F����ا���"ة ��� ا��

Title="�Mه ?Mا� -I"
ه% آ�ن إذا:'k�ل ��ا ا=ر�S�ط� )�fVد ا%Lا� 

<p><a href="http://www.des4arab.com/index.htm">��� <a></p/>ا�"@���� ا� 
 ا�L%د *+� ا
I��CgS �P �Cن

## �B8q4 ا

� ��Aرب و����� :��*#����\�A#� أو
�`Pا%*a�* b���أو G	Z+_ NML اPV`" أو ا� %ر أو ا�M	�ذجC٢٠٠٠"وDS�G �' E� ًا���S� أو �ر*ً�D� Z.أو أ "kاول أآ�eا� �GTA

 ����G �' أو... Nوذ� )��F��آ:

1- gFCا �	@�. Format "FAوا Paragraph . 
2- gF��P ار%� -*"' Paragraph ... ���A E' Spacing NML	G ~�� ���SFرب أو ا��DFا� ZG�+أن�:
(أ Before: ص�A "���F* �' �C��'�DS�G .
(ب After : ص�A "���F* ���G �' �C��'.

## ��'�. �A� �*� ]�0و� "B8ا/� "T�,	/<�= 0; ا� �	٢٠٠٠= إ:
NML	Gg� F	ام ا��lFPا E' =ً�* a�* b���NF *%اC �`P"وf "����'aأو "* ftp  )��F��آ Nوذ�:



�


1- gFCا �	@�. File H�Iوا U�� Publish Web . 
2- RFان اآ%M� U��Vا )C N+.%' Gأ RFآ�C E�+' ��e	� ت���، وإن اردت ارP�ل ا�  Tً'�آZk' ��e	ه�ا ا� ,Pا �d:

http://www.des4arab.com/HTML.  
3- H�Iزر اPublish )CZ�PVا.
4- gF��P �	م وآ��lF�	ا� ,Pا ��C RFاآ ،   .OK ا�l�* �f	W N+.%, اH�I ا�	"ور '"*-


�� ار���ط	-'4�4 �yاk	ا de1 4Z
: 	���4ك 
Z/ان ا	��8	" 
1- Z�n ط�Sار� o�G"� ا��ي ?Mك�ا��G"S.Zk' "�M* Z ا�“.
2- gFCط ا�Sء ا=ر����" '"*- �%ار إ Create Hyperlink”.  
3- )C���A URL ان%Mك و��G"* ان%M� "���� -' ، )��Fا� RFاآ ���P"ا�:

 ،، ��	-/ �*0	�X*:5... ��$/ا أن �T/�/ا <4 ا8-���4  .... دروس ا	��و�[ �*� �#��"

:ا0�j-8h" ا	:��5; د	*�

�ن �/ع ا	:���ت ��Aا	:�4A" ا	:\��" ا	:/<X ا�8uا�ــ� اk:	ا 

Arab4Hom15 MB � ���� ا	:-��
 ا�0�1ت-��	���*" ا	:/<X آ���-را�y" �/ا.��ت
	 .. د
� �� ;Z0	���X>/:-"* و�/#8 �T	k*:� "ة

�*<T	آ� وا�p-Z� k*::	ا X>/:	0; ه`ا ا.
Spaceports��� ود��	 FTP �
�� CGIi , PHP , MySQL , SSI 

3DK�*� 4ود'� ���� CGIi , PHP , MySQL , SSI 

Xoasis20 MB ���� CGI , PHP 
S2F20 FTP ون�� CGI , PHP , MySQL , SSI 

Virtual 
Avenue20 MB FTP ر$*" ��0`ة�i 

�
ا	:\��" ���8 ر�d-د
� �0و�[ �*�  - cgi د
 @��A" ا�8h-ا	�BZق

http://you.virtualave.net 

CROSSWINDS�*� 4ود'� �- ا	:-�� FTPر$*" ��0`ة�i 

� 	= �:\��" ه`ا:\� X>/:	و�4ون ��-/�" ا
4��� ='Z:� آ:� أ�� ، : آ�	-�	; pop3 إ
���ت

username@crosswinds.net ��-و�� 
، ا�8 �/<�= �� أ8#� وأ�8ع ا	:/ا<X 	��-�اك

. اi-��رo و	T*8 ..=ZT:� �T/ن @/��

netfirms25 MB FTP ���� 
X��8 -�*� ]�0و� �
و�:CGI -  =ZT و�4
� د

 @��A"-ر�d ا	:\��" ���8 ا	�BZق ا	�7ص �=
�8hا :http://you.netfirms.com . 

Hypermart20 MB FTP ر$*" ��0`ة�i 
�
-���8 ا	�BZق ا	��d-د
� �0و�[ �*�  - cgiد

 @��A" ا�8h-وأدوات أ�iى �:�T إ0�1-#�
http://you.hypermart.net  

http://www.hypermart.net/
http://www.netfirms.com/
http://home.crosswinds.net/sign_up/
http://www.virtualave.net/
http://www.virtualave.net/
https://secure.freedom2surf.net/products/free/signup.php3
http://www.xoasis.com/home.html
http://www.dk3.com/dk3page.pl?id=hosting
http://www.spaceports.com/
http://www.home4arab.com/


��

Geocities12 MB �- ا	:-�� FTPر$*" ��0`ة�i "A��@ �8hا 
http://www.geocities.com/you 

FreeServers20 MB �- ا	:-�� FTP���� 
-���8 ا	�BZق ا	:\��" ر�d-�7-�� $4اً ا�8

�8hا "A��@ http://you.8m.com  
http://you.8k.com و�*�ه� 

:	�AZ ا	:���ت ftp ������ ��ح
#"B8:���ت �/ا	ا �A� :���ت ��و�/آ/ل	ا �A� (ftp) : 
ال هM�ك a'ا"* E' �G�+ا� ftp ،%ه �Mم *�"�� ه%DMP ا��ي a'��"Sوا� WS_ftp pro %ا.- ا��ي	ب ا���fأ E' �G�+ا� �'�lF�G

�l���( G	NML ا�� %ل �e' a'��. هM� *���M' H�d آ�'��وه% *"

:ا	������ @��A" ا8-47ام#
1- gFCا ZLا�� NG�� "�O�P a'��"Sا�)��Fا�:

2- H�Iا ZLا�� N� "�O�P Uا� %رة أ�� )C �	آ)��Fا� :

3- RFاآ "A� -.%' E' ��dF�	ف ا�TFAة ا�ا�"' -' Uا� %رة أ�� )C �	آ ...,WH�Iا Finish "�O�P ZLا��)��Fا�:

http://www.des4arab.com/home/modules.php?name=Downloads&d_op=getit&lid=1
http://www.freeservers.com/
http://www.geocities.com/


��

4- RFك اآqe� �M� �G"Sا� �`Pا%* ����� b� � )F"ور ا�	ا� �	م وآ��lF�	ا� ,Pا o���Z اH�I... ا�	���� �PVا )Cو Save 
... 
)Cرو��G a'��"Sا� ZLا�� )C �	آ �F�I%.- ا��ي أ	ا� �eFP)��Fا� :

�" Connect *��	�وس ��W N+.%' U, اH�I أ[" -5O�P )��Fا� :



��

"OF��� ر., *���"آ� �FG UF, ا=� �ل ا�lا� gF���'a ا�lFPا'�ت و�C	� )�G ["ح Vه,.. ا�l�* �f	U�� N+.% ا��٢(�LS( و�"Sا�
 .. ��%�P ZL* Z	+G ���� �eFP أ+Sا�:

( 1 ) ��ت _��زك =FP+"اض:�'.
( 2 ) FP= )C+"اض: N����' �LSا�� .
( 3 ) :ZDM� �LSا�� Uز إ���eا� E' N����' " upload " . 
( 4 ) :ZDM� ز��eا� Uإ� �LSا�� E' ت��" ا�	� Download " . 
( 5 ) :"D� U��V اض"+FPT� �_دوq' ة"D� "dAVا ,�. ا��
( 6 ) :"���F� ��e	ا�.
( 7 ) ���ء:
 �G�_ ��e'.
( 8 ) ��� ا�	^[" ����� HTML اFP+"اض: �� .
( 9 ) 
��دة: ��e	أو ا� ��	ا� ��	��.

( 10 ) : �'�M� �	آ� "�O� Z F' ن%L� close آ�"���* N�� ا� -`D� )وه .
( أي ��l"وج : ( 11 a'��"Sا� E' "قT{إ".

** �O�T' **  
-�	_�D`M	ا� )C زرارVا B��� )C �# �	Z اVزرار� �D`M	ا� AفTFA�* N����	* �f�A ���.*����LSأ

 ا	������ 	�/./ل إ	� �\��= 8*'-�$#� ا	-; 	:��/��تا
�� ا�d%رور�G ا�F( ا�	+�%'�تS�`�P a'��"* FTP �M' تqe� %.- ا��ي	ا� )C N*��� Uل إ�%f%�� Nوذ� ،  '���� ��M ا
��اد

)C "A� -.%' E' ��Fl� ����e'Host Name / IP Address  HDC ...ح�dGإ Nوإ�� �DG"`ا� :

Host Name / Address : Y'�¤ �Fp ����  �.
User ID : ,Z� S	^���� �;H B:��F� }O�� N�{��.�.

Password : */�� S	^���� �;H B:��F� }O�� }����.

_p�
 _q �+
 �/'+: "������ �§
 B;� �'���
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http://www.des4arab.com/home/modules.php?name=Downloads&d_op=getit&lid=20

